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Recap

Reinforcement learning overview.

Q-learning and why Q-tables fail for CartPole.

Deep Q-Network (DQN): replay buffer and target network.

Practical workflow of CartPole training and testing.
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Lecture 7

Why move from CartPole to the rotary inverted pendulum.

Hardware system introduction: motor, sensors, motor driver and
STM32F446RE microcontroller.

Nonlinear dynamics modelling by the Lagrange method.

Arduino IDE setup, flashing and debugging for STM32F446RE.
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Why move from CartPole to the rotary inverted pendulum?

CartPole is a very useful first benchmark, but it is still a software environment.

The rotary inverted pendulum is more suitable for the next stage because

it is a portable experimental platform,

it is nonlinear, coupled, and underactuated,

So the course now moves from a toy benchmark to a real hardware system.
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From simulation to real hardware

CartPole Rotary Inverted Pendulum

next

The real system introduces several new issues:
sensors ,
motor driver and PWM,
embedded code,
communication delay.
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Overall hardware system

Typical hardware modules:

rotary arm and vertical pendulum,

angle sensors,

DC motor and TB6612 driver,

STM32F446RE control board,

host computer for data logging.
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Hardware architecture

Sensors

Motor

Rotary inverted pendulum

TB6612
driver

STM32F446RE
(deploy the ex-
isting network

and execute the
control loop)

PC
(only receive

and store logs)

sensor data

PWMdrive

logs

CDC virtual serial communication
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Motor

The horizontal arm of the rotary inverted pendulum is driven by a DC motor with a
gear reduction mechanism.

Important motor parameters:
Rated voltage�Rated torque
Stall torque: maximum torque when
the motor shaft is blocked.
Gear ratio: ratio between motor-shaft
rotation and output-shaft rotation.

ωout ≈
ωmotor

N , τout ≈ ηNτmotor.

Motor used in this system:

Rated voltage 12 V
Rated current 0.36 A
Rated power 4.32 W
Rated torque 0.06468 N · m
Stall current 2.8 A
Stall torque 0.6468 N · m
No-load speed 11000 rpm
Output speed 549 ± 15 rpm
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Sensors

The rotary inverted pendulum needs at least two angle-related measurements:
arm angle θ,
pendulum angle α.

Typical implementations include
incremental encoder for the rotary arm,
potentiometer or angle sensor for the pendulum.

From these measurements, we can further estimate the angular velocities

θ̇, α̇

using an observer.
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Sensor: Magnetic encoder

A magnetic encoder measures rotation by detecting the change of magnetic field.

In this system, the motor tail is equipped with an incremental magnetic encoder.

When the motor shaft rotates, the magnetic encoder generates pulse signals.
The number of pulses reflects angular displacement.
The pulse density reflects rotational speed.
Two phase-shifted signals are used to determine direction.

Therefore, the encoder provides the basic measurement for the rotary arm angle:

encoder pulses =⇒ θ.
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A/B phase signals and rotation direction

An incremental encoder usually outputs two square-wave signals: A phase and B phase.

A phase and B phase have the
same frequency.
Their phase difference is
approximately 90◦.
The leading phase determines the
rotation direction.

For example:
if A phase leads B phase, the
shaft rotates in one direction;
if B phase leads A phase, the shaft
rotates in the opposite direction.
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From encoder pulses to rotation angle

For this motor encoder, one motor-shaft revolution generates 13 pulses.
The gear ratio is approximately 20 : 1, meaning that the motor shaft rotates 20 turns
while the output shaft rotates 1 turn.
Therefore, one output-shaft revolution generates 13 × 20 = 260 encoder pulse periods.
Because both A and B phases are counted on rising and falling edges, each pulse
period provides four countable edges:

260 × 4 = 1040.

Thus,

360◦ ⇐⇒ 1040 counts, 1 count ⇐⇒ 360◦
1040 .
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Firmware: counting encoder pulses

In the STM32 firmware, the encoder A/B signals are connected to two external
interrupt pins. The variable g_enc stores the accumulated encoder count.

static const int PIN_ENC_A = 2;
static const int PIN_ENC_B = 3;
static volatile int32_t g_enc = 10000;
void setup() {
pinMode(PIN_ENC_A, INPUT);
pinMode(PIN_ENC_B, INPUT);
attachInterrupt(digitalPinToInterrupt(PIN_ENC_A),

isr_enc_a, CHANGE);
attachInterrupt(digitalPinToInterrupt(PIN_ENC_B),

isr_enc_b, CHANGE);
}

Each rising or falling edge of A/B triggers an interrupt, so the firmware can count
pulses without continuously polling the encoder in the main loop.
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Firmware: direction judgment by A/B phase

Whenever A or B changes its logic level, the corresponding interrupt service routine is
called.
void isr_enc_a() {
bool A = digitalRead(PIN_ENC_A);
bool B = digitalRead(PIN_ENC_B);
if (A) g_enc += (B ? 1 : -1);
else g_enc += (B ? -1 : 1);

}
void isr_enc_b() {
bool A = digitalRead(PIN_ENC_A);
bool B = digitalRead(PIN_ENC_B);
if (B) g_enc += (A ? -1 : 1);
else g_enc += (A ? 1 : -1);

}

This logic uses the current A/B levels to decide whether the count should increase or
decrease.
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Firmware: from encoder count to arm angle

When the command GO is received, the current encoder count is saved as the zero
position:
if (t == "GO") {
noInterrupts();
ENC_ZERO = g_enc; ...
interrupts();

}

During each control tick, the firmware reads the current encoder count and converts it
to the arm angle:
int32_t enc = g_enc;
int32_t enc0 = ENC_ZERO;
g_theta_meas = (float)(enc - enc0) * THETA_SCALE;
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Sensor: potentiometer

The pendulum angle α is measured by a potentiometer connected to the STM32
analog input pin.
A potentiometer is a variable resistor. As the pendulum rotates, its resistance changes
and produces a different analog voltage.
The STM32 ADC converts this analog voltage into a digital value.
static const int PIN_POT = A0;
static const int32_t POT_MOD = 4096;

pinMode(PIN_POT, INPUT);
analogReadResolution(12);

Because 12-bit ADC is used, the raw potentiometer value is in the range

0 ≤ pot_raw ≤ 4095.
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From potentiometer value to pendulum angle

Two calibration values are used in the firmware:
static volatile int32_t POT_ZERO = 3090; // upright position
static volatile int32_t POT_DOWN_RAW = 980; // hanging-down position

The firmware reads the potentiometer in each control tick:
int pot = analogRead(PIN_POT);
g_pot_raw = (int16_t)pot;

float alpha_branch = alphaFromPotRawBranchCutAtDown(pot);
g_alpha_meas = alpha_branch;

pendulum angle → resistance → voltage → pot_raw → α.

Here, POT_ZERO corresponds to the upright position, and POT_DOWN_RAW is used to
define the branch cut near the hanging-down position.
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Motor driver: TB6612

The STM32 GPIO pins can only output low-power logic signals, so they cannot drive
the DC motor directly.
The TB6612 motor driver is used as a power amplifier between the STM32 and the
motor.

VM: motor power supply.
VCC: logic power supply.
GND: common ground.
AO1, AO2: motor output
terminals.

The TB6612 receives control signals from STM32 and provides higher current to the
DC motor.
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TB6612 control pins in firmware

For one DC motor, the STM32 mainly controls three types of signals:
PWMA: controls motor speed / torque level by PWM.
AI1, AI2: control motor rotation direction.
STBY: enables or disables the motor driver.

In the firmware, the corresponding pins are:
static const int PIN_IN1 = 4; // AI1
static const int PIN_IN2 = 5; // AI2
static const int PIN_STBY = 7; // STBY
static const int PIN_PWM = 10; // PWMA

STM32 PWM + direction → TB6612 → DC motor → rotary arm.
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STM32F446RE development board

The STM32F446RE is the real-time controller of the
rotary inverted pendulum system.
Main tasks:

reading potentiometer by ADC;
counting encoder pulses by external interrupts;
generating PWM for the TB6612 driver;
executing the control loop at a fixed frequency;
communicating with the host computer
through USB serial.

It connects sensing, computation, and actuation in the
embedded control loop.
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Physical model of the rotary inverted pendulum

The rotary inverted pendulum consists of two rigid
bodies:

horizontal rotary arm OB,
vertical pendulum BD.

We define two generalized coordinates:

q1 = θ, q2 = α.

θ: rotary arm angle;
α: pendulum angle relative to the upright
position.
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State variables and modelling objective

The system state is defined as

x =
[
θ θ̇ α α̇

]⊤
.

The goal of physical modelling is to derive the dynamic relationship between the motor
input and the system motion:

u =⇒ θ, θ̇, α, α̇.

The rotary inverted pendulum is
nonlinear,
coupled,
unstable around the upright equilibrium.

Therefore, we first build a nonlinear model and then linearize it around the upright
position.
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Lagrange equation

The dynamics are derived using the Lagrange equation:

d
dt

(
∂T
∂q̇i

)
− ∂T

∂qi
+

∂U
∂qi

= Qi, i = 1, 2.

Here,
T is the total kinetic energy,
U is the potential energy,
Qi is the generalized force corresponding to qi.

q1 = θ, q2 = α.

The two Lagrange equations give the coupled dynamics of the rotary arm and the
pendulum.
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Physical parameters and generalized forces

Symbol Meaning
m1 mass of the rotary arm OB
m2 mass of the pendulum BD
l1 distance from O to the center of mass of arm OB
l21 distance from joint B to the center of mass of pendulum BD
I1z moment of inertia of arm OB about its z axis

I2x, I2y, I2z moments of inertia of pendulum BD about its body axes
cθ viscous damping coefficient of the rotary arm
cα viscous damping coefficient of the pendulum
τ motor output torque

Qθ = τ − cθθ̇ generalized force corresponding to θ

Qα = −cαα̇ generalized force corresponding to α
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Kinetic and potential energy
The total kinetic energy is composed of the arm part and the pendulum part:

T = TOB + TBD.

The rotary arm contributes rotational kinetic energy:

TOB =
1
2m1l21θ̇2 +

1
2 I1zθ̇

2.

The pendulum contributes both translational and rotational kinetic energy:

TBD =
1
2m2v2

C +
1
2
(

I2xα̇
2 + I2yθ̇

2 sin2 α+ I2zθ̇
2 cos2 α

)
.

The potential energy comes from gravity:

U = −m2gl21(1 − sinϕ).
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Nonlinear dynamic equations

After substituting T and U into the Lagrange equations, the nonlinear coupled
dynamics can be obtained.
Using α = π

2 − ϕ, the equations can be written as(
m1l21 + I1z + m2l21 + m2l221 sin

2 α+ I2y cos
2 α+ I2z sin

2 α
)
θ̈

+ (m2l1l21 cosα)α̈− (m2l1l21 sinα)α̇
2

− 2 sinα cosα
(
I2y − I2z − m2l221

)
α̇θ̇ = Qθ,

− (m2l1l21 cosα)θ̈ + sinα cosα
(
I2z − I2y + m2l221

)
θ̇2

− (I2x + m2l221)α̈+ m2gl21 sinα = Qα.
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Linearization around the upright equilibrium

We linearize the nonlinear dynamics around the upright equilibrium:

θ = 0, α = 0.

Near the upright position, the small-angle approximations are

sinα ≈ 0, cosα ≈ 1, α̇2 ≈ 0, θ̇2 ≈ 0.

After neglecting higher-order nonlinear terms, the nonlinear equations become(
m1l21 + I1z + m2l21 + I2y

)
θ̈ + m2l1l21α̈ = Qθ,

−m2l1l21θ̈ −
(
I2x + m2l221

)
α̈+ m2gl21α = Qα.
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Linearized model

Define four constants:

C1 = m1l21 + I1z + m2l21 + I2y, C2 = m2l1l21,

C3 = I2x + m2l221, C4 = m2gl21.

Then the linearized dynamics can be written compactly as

C1θ̈ + C2α̈ = Qθ,

−C2θ̈ − C3α̈+ C4α = Qα.

Where

Qθ = τ − cθθ̇, Qα = −cαα̇.
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State-space form

After solving the two linearized second-order equations for θ̈ and α̈, the system can be
written as

ẋ = Ax + Bτ.

The symbolic form is

d
dtx =


0 1 0 0
0 d1 a1 d2
0 0 0 1
0 d3 a2 d4

 x +


0
b1
0
b2

 τ.
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State-space form
For the state vector

x =
[
θ θ̇ α α̇

]⊤
,

the linearized model can be written as

ẋ =


0 1 0 0
0 d1 a1 d2
0 0 0 1
0 d3 a2 d4

 x +


0
b1
0
b2

 τ.

where

a1 = − C2C4
C1C3 − C2

2
, a2 =

C1C4
C1C3 − C2

2
, b1 =

C3
C1C3 − C2

2
, b2 = − C2

C1C3 − C2
2
,

d1 = − C3cθ
C1C3 − C2

2
, d2 =

C2cα
C1C3 − C2

2
, d3 =

C2cθ
C1C3 − C2

2
, d4 = − C1cα

C1C3 − C2
2
.
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From motor torque to PWM command

The mechanical model uses motor torque τ as the input, but the real system sends a
PWM command u through STM32 and TB6612.
Therefore, we need a DC motor model to connect the implemented command to the
physical torque:

u =⇒ τ.

For a DC motor,

Vemf = kiω, I = Vs − Vemf
R , τ = ktI.

where Vemf is the back electromotive force, ω is motor angular velocity, Vs is the
applied voltage, R is armature resistance, I is motor current, and kt, ki are motor
constants.
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PWM-to-torque relation

The motor voltage is approximately proportional to the PWM command:
Vs = kuu.
Substituting this into the DC motor model gives

τ = kt
Vs − kiω

R =
ktku
R u − ktki

R ω.

Therefore,

τ = Kuu − Kω θ̇,

where

Ku =
ktku
R , Kω =

ktki
R .
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Substituting PWM input into the state-space model
Before considering the motor electrical model, the linearized mechanical model is

ẋ = Aτx + Bττ,

where

Aτ =


0 1 0 0
0 d1 a1 d2
0 0 0 1
0 d3 a2 d4

 , Bτ =


0
b1
0
b2

 .

From the previous slide,

τ = Kuu − Kω θ̇.

Therefore,

ẋ = Aτx + Bτ

(
Kuu − Kω θ̇

)
.
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PWM-input state-space model

Since the state vector is

x =
[
θ θ̇ α α̇

]⊤
,

the term θ̇ is the second state variable.
Thus, the back-EMF term −KωBτ θ̇ is absorbed into the second column of the state
matrix:

ẋ = A1x + B1u,

where

A1 =


0 1 0 0
0 d1 − Kωb1 a1 d2
0 0 0 1
0 d3 − Kωb2 a2 d4

 , B1 =


0

Kub1
0

Kub2

 .
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State-space form

After substituting the physical parameters, the final linearized model is

ẋ(t) = A1x(t) + B1u(t),

where u(t) is the motor PWM command, and

A1 =


0 1 0 0
0 −11.3205 −49.9955 0.4820
0 0 0 1
0 16.9206 171.2602 −1.6510

 , B1 =


0

0.8171
0

−1.2213

 .

This model describes the local dynamics of the rotary inverted pendulum near the
upright equilibrium.



huangxun@pku.edu.cn AI Enabled Control Engineering 2026 Summer 36/42

Arduino IDE setup for STM32F446RE

Arduino IDE can be used as a lightweight development environment for
STM32F446RE.
The basic workflow is:

1 install Arduino IDE 2,
2 add the STM32 board package URL,
3 install STM32 MCU based boards,
4 select the correct STM32F446RE board,
5 choose the upload method,
6 compile and upload the firmware.

This allows us to write Arduino-style sketches while still running them on the STM32
microcontroller.
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Install STM32 board package

Open Arduino IDE:

File → Preferences → Additional Boards Manager URLs

Add the STM32duino package index URL:
https://github.com/stm32duino/BoardManagerFiles/raw/main/

package_stmicroelectronics_index.json

Then open:

Tools → Board → Boards Manager

Search for
STM32 MCU based boards

and install the package.
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Select the STM32F446RE board

After installing the STM32 board package, select the board in Arduino IDE.
For the STM32F446RE Nucleo board, the typical selection path is:

Tools → Board → STM32 MCU based boards → Nucleo-64

Then select the board part number:

Board part number → Nucleo F446RE

Other useful settings are usually:
Upload method: OpenOCD STLink .
Port: select the USB serial port of the board.



huangxun@pku.edu.cn AI Enabled Control Engineering 2026 Summer 39/42

Upload firmware to STM32F446RE

Connect the STM32F446RE board to the computer through USB.
1 select the correct board , board part number and upload method,
2 select the correct port,
3 click Verify to compile and click Upload to flash the firmware.

A minimal test program is:
void setup() {
pinMode(LED_BUILTIN, OUTPUT);

}
void loop() {
digitalWrite(LED_BUILTIN, HIGH);
delay(500);
digitalWrite(LED_BUILTIN, LOW);
delay(500);

}
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Serial monitor test
After uploading the firmware, we can use Serial Monitor to check communication.
Open:

Tools → Serial Monitor

Set the baud rate to the same value used in the firmware, for example:
void setup() {
Serial.begin(115200);

}
void loop() {
Serial.println("STM32 serial OK");
delay(500);

}

If the setup is correct, the Serial Monitor should repeatedly print:
STM32 serial OK
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Flashing and debugging checklist

If upload or serial communication fails, check the following items:
Is the STM32 board package installed?
Is Nucleo F446RE selected as the board part number?
Is the correct upload method selected?
Is the correct USB port selected?
Is the USB cable a data cable rather than a charging-only cable?
Is the Serial Monitor baud rate the same as Serial.begin()?
Is another program already occupying the serial port?
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Summary

In this lecture, we moved from a software benchmark to a real rotary inverted
pendulum platform.

Hardware system.
Sensing and actuation.
Physical modelling.
PWM-input state-space model. the motor torque model was combined
with the mechanical model to obtain

ẋ(t) = A1x(t) + B1u(t),

where u(t) is the PWM command.
STM32 development workflow.


